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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 20-16
KANNADA
(Basic)
(New Syﬂabus)
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016
' : KANNADA
(Basic)
(Old Syllabus — Last Chance)
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2019 =
ENGLISH
. (Basic)
(New Syllabus)

%) ~en €
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()

Time : 3 Hours] . ' [Max. Marks : 80

I1.

IIL

Text: Living Biographies

Answer the following questions in a word, or a phrase : (10 x 1 = 10)

S0,/ eN 0N QN i O9 N W=

‘Sorrow of the child’, is an extract from Charlie Chaplin’s :
Name the School where Sydney and Charlie were sent. -

- Why did one of the priests call Dom Moraes mad?

Mention the name of the book in which G.B. Shaw’s biographical sketch appeared.
Name the book which Dom Moraes opened in Catechism class.

How much did G.B. Shaw earn from his first nine year works?

Why did Gandhiji go to Africa?

All the Hindus in South Africa were called

‘Mahatma Gandhf’, is an extract from Bertrand Russell’s collection of essay’s

10 Who is Manilal Gandhi?

Answer the following questions ina sentetlce or two (any five) : : (b:x2=10)

S OOy SO S5O0 SN IRES

What was the court decree that, Charlie and Sydney heard? :
What was the prize for the essay competition that Dom Moraes entered"
Which action of the Father shocked Charlie? -

Why did Shaw hate the work of a cashier-clerk?

How did Shaw overcome his inferiority complex?

Where did Dom Moraes want to settle and why?

Who led the campaign against salt-tax at Dharsana?

: What is the essence of Satyagraha?

Write a note on pathos of the life of estranged parents and children as revealed in ‘Sorrow
of childhood’. , (10)

. : Or
Discuss Dom Moraes’ feelings of being rootless in India as revealed in ‘At School’.

Give an account of Shaw’s struggles against humiliating circumstances in Dublm and
London _ (10)
Or & -
Explain Gandhiji’s experlences in the stage coach he was travelling from Natal to
Johannesburg.
[P.T.O.
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V. Write short notes on any two of the following: Bix2:=

i
4.

VI. a)‘

b)

VIL. a)

A.b)

Louise = 2. 'Steph_en Spender 3. Miss Charlotte Paye-Townshend
Colour prejudice

Frame the questions so as to get the underlined words as answers: (5

i) He is reading Gulliver’s Travels

ii) . Rahim has taken my pen.

iii) - She writes to her father every week.
iv) Bangalore is the capital of Karnataka.
v) Arati wrote a letter to Suhasini.

Frame hew words by using affixes: : ) ' : : (5x 1
i) Polite ’ ’
ii) Possible
iii) Care
iv) Kind
~v) Sense.
Fill in the blanks with correct forms of verbs in the brackets : | Bx1
D It raining -i‘ncessantly (to be)
ii) Yesterday the police ___ all the vehicles (check)
iii) He was by his friend (to lead)

iv) I. you in the market last evening (to see)

'v) 20 Twenty maiden tournament was - by India (win).

Give one word substitute to the following: : (5x1

i) - Life history of a person written by oneself.
ii) Killing oneself. ' _
iii) A'place where animals are kept for show.
iv) A song sung by a single person

v) One who eats no meat or fish.

VIII.Write an essay in about 200 words on any one of the following:

165
2.

Elections .
Natural Calamities.
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016
il ENGLISH
(Basic)
(Old Syllabus-Last Chapce)

~Time: 3 Hours] S [Max. Marks : 8
' : Text: Popular Short Stories. |
1. Answer the following questions in a word, a phrase or a sentence each : (10 < 1= 1(
a) What is the name of the poor girl in ‘A Cup of Tea’?
b) Who is the author of A Cup of Tea’?
¢) Who was Della’s husband?
d)’ What are the two possessions in which the couple in ‘The Gift of Magl took pnde‘?
e) What is the name of the gateman in ‘The Gateman’s Gift’?
f) How many years did the gateman serve at the office?
g) Mention the name of Kadambini’s friend.
h) Who carried the dead body of Kadambini to graveyard?
i) From whom did Pahom borrow the rest of the money to buy land?
j)  Mention the name of the writer of ‘How Much Land Does a Man Need’.
2. Explain with reference to context (any two) : . ‘ s - Bx2=1
a) “She’s absolutely lovely. Look again, my ch11d I was bowled over when I came into yot
* room just now”. :
b) “Just take it back and say you have not found me...”
c) “What?... keep you like a servant! Why, you are my closest frlend”
d) “Please God, make him think I am still pretty”.
3. a) Write a note on the struggles of Kadambini. : (a
: : . Or - ' '
b) Describe the scene in which Jim and Della show their gifts to each other.
Sketch the character of Govind Singh. et : 61
: Or - : : '
b) How does Pahom become a victim of greed and ambition? Explain.
5. Write short notes on any two of the followmg @2x5=1
a) Rosemary Fell '
b) Govind Singh’s masterpiece
c) Crematlon of Kadambini
d) The ending of the story ‘A Cup of Tea’.

[P.T.
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a) Frame questions so as to get the underlined words as answers: (Bexil=

i) Suma gave a flower to the child.

ii) The children went to school yesterday.
iii) Mohan works in INFOSYS.

iv) He passed BA in 2010.

v) The students go to college by bus.

b) - Form new words by using affixes: | (5 x 1 =

i) Care

iil) Govern

iii) Aim

iv) Sense

v) Burden.

a) Fill in the blanks with correct forms of verbs given in the brackets : . (BGxl=

i) He . writing a letter. (to be)

ii) Hari a snake yesterday. (to kill)

iii) The earth ~_round the Sun (to move)

iv) We our holidays in Ooty last year. (to spend)
v) Lata _a prize at School. (to win).-

'b) Write a letter to the Principal of a College, requestmg him to issue you the transfer
certificate.

Write an- essay in about 200 Words on any one of the following :
a) Values in Higher education
b) Woman education.

a
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016
HISTORY AND ARCHAEOLOGY '

History of India (From 1526 AD to 1707 AD)
(India Map to accompany)

- Time : 3 Hours] R : [Max. Marks: 80

* Answer all Sections.
Follow the Instructions carefully
Section A — (Marks: 10x2= - 20)

Answer any ten questions in 4 to 5 sentences each.

Tuzuk-i-Babari ' 2. Battle of Bilgram

Bulund Darwaza. : 4. Battle of Haldighati -
Sikander. ' | 6. Sir Thomas Roe.
Mumtaz. : : 8. Dara Shukoh.

Jijabai ' 10. Ratnagiri Fort.

Guru Granth Sahib - 12. Khwaja Moinuddin Chisti.

Section'B — (Marks: 4 x 5 = 20)
Answer any four questions in 20 to 25 sentences each. -

Describe the sources of Medieval Indian History.
Describe the difficulties faced by Humayun.
Give an account of Akbar's Rajaput Policy. . .
Revenue Administration under.the M'ughals. ;
Causes for the Down fall of the Mughal Empire.
Write about Sufi Movement. !
- Sectlon C - (Marks: 3 x 10 = 30)

~ Answer any three questions in 50 sentences each.
Shahjahan's penod was the Golden Age of Mughal Art & Archltecture Discuss.
Explain the Military achlevements of Aurangzeb.
Describe the conquests of Shivaji. |
Discuss the origin, spread and results of Bhakti Movements. .

' Section D — (Marks: 4 + 6 = 10) -

On the outlme map supplied to you mark the places conquered by Akbar the great and write an

For Blind Students only.

Describe the coriqgests of Akbar. ; 3] 10
E ' [P.T.O
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016
ECONOMICS

INTERNATIONAL ECONOMICS
Time : 3 Hours] [Max. Marks : 8

Answer all the three Sections.
Answer to all the questions of Section-I should be written continuously.

Section - I (Marks: 10 x 2 = 20)

1. Answer any ten of the following questions in 2-3 sentences each.
(a) What is absolute cost?
(b) What is Factor Endowment?
(c) State the meaning of Export - Trade.
(d) What is Free Trade Policy?
(e) What is tariff? .
(f) State the meaning of current account.
(g) What is Foreign Exchange Market?
(h) Give the meaning of dumping.
(i) What is SDR?
(G) Give the meaning of devaluation of money.
(k) Name the currency of France and Germany.
(1) Whatis W.T.O?

Section - IT (Marks: 3 x 5 = 15)
Answer any three of the following:

Explain the distinction between Internal and International Trade.
Explain the arguments for Free Trade Policy.

Examine the difference between balance of payment and balance of trade.
Discuss the functions of foreign exchange market.

Explain the objectives of W.T.O.

Section - ITI (Marks: 3 x 15 = 45)
Answer any three of the following questions:

7. Explain Hekscher-Ohlin theory of International Trade.

8. What is terms of trade? Discuss factors determining terms of trade.

9. Discuss the arguments for and against of protected trade policy.

10. What is foreign exchange rate? Explam arguments for and against of ﬁxed exchange rate.
11. Describe the objectives and functions of LM.F.

il

[P.T.
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016

(New Course)

SOCIOLOGY
(Study of Western Social Thought)
Time : 3 Hours] : i \"?jl\_{[,arks : 80
7 NQ

Answer all questions subject to internal choice.
All questions carry equal marks.

1. Explain Auguste Comte’s views on “Law of three Stages”.

Or Q’EE/’/’ i

Discuss Auguste Comte’s views on ‘Social Static and Social Dynanii’c’. | - (8+8=16)

2. Discuss the views of Herbert Spencer on ‘Social Evolution’. (16)
Or

Examine Herbert Spencer’s views on ‘Organic Analogy’. . ' (16)

3. Discuss the Karl Marx’s views on ‘Historical Materialiém’. (16)
| or

Analyse the Marxian Theory of Alienation. (16)

4. Explain the views of Max Weber on Ideal Types. : (16)

. = :
Discuss the causes and types of suicide according to Durkheim. . ' (8+8=16)
5. Write noteé on any two: (8+8=16)

(a) Hierarchy of .Sciences
(b) Types of Society
- (e¢) Class struggle

(d) Division of Labour.

[P T0.
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FOURTH SEMESTER B.A./B.Sc/B.S.W. DEGREE EXAMINATION 2016
COMPUTER APPLICATIONS (Compulsory)

Total No. of questions : 80 ‘ ' _ Time : 90 Minutes_
’ Max. Marks : 80 ‘ _. '
: Mp
= T %D
; L : i D \C{::,
INSTRUCTIONS TO THE CANDIDATE g

1. The question paper will be given in the form of a Question Booklet.

2. Immediately after the commencement of the examination, the candidate should check
~ that the question booklet supplied to him contains all the 80 questions in serial order.
The question booklet does not have unprinted or torn or missing pages and if so he/she
should bring it to the notice of the Invigilator and get it replaced by a complete booklet.
This is most important. : < '

3. A Blank Page of the question booklet niay be used for rough work.

- 4. Each question is provided with fbur choices (a), (b), (¢) and (d) having one correct answer.
Choose the correct answer and darken the bubble corresponding to the question number
using Black Ball Pen in the OMR answer sheet. .

5. Each correct answer carries 1 mark and no negative mark for unattended questions.

6. No candidate will be allowed to leave the examination hall till the end of the session and
without handing over his/her Answer Sheet to the Invigilator. Candidates should ensure
that the Invigilator has verified all the entries in the Register Number Coding Sheet and
that the Invigilator has affixed his/her signature in the space provided.

7. Strict compliance of instructions is essential. Any malpractice or attempt to commit any
kind of malpractice in the Examination will result in the summary disqualification of
the candidate. : '

8. Mobile phones are not allowed in the exam hall.

9. Simple calculators are allowed but not scientific (_:alc_ulatbrs.

[B.T.0.



1. Abacﬁs is

a) A Computing Device  b) Store Device c) Output Device
VTS QTR0 &SN,

©) ogpLon® @a”,o / éﬁé LRlan]
) :om-—s asx*

B) A0 B

2. Analytical Engine was designed by......
- a) Charles Babbage

c) George Boole : '
- DFETHOZT 0BT / OPOZ-———— Q0T DTVRRLPIOLI.

2.9 zsaoff 2ees”
- B) [E wede

b) John Napier

a) A Central Processing Units .

¢) Input and Output units
TOTRET 83 IINT odsaaz)dab BRODT 2

~®) 3eodeod R Roxom s ) BOED ez
) {osea?,d / ANES [

4. - The use of Transistors was introduced in....."
a) First Generation Computer '
¢) Third Generation Computer

) BeDTo @cﬁé#

b) A Memory Unit
d) All of the above

B) a@rsd SO

6159 — IVS (DM) — CA— MAY —

d) Input Device

d) John Von Neumann

u) pAnid éewojoof
. @) TS SRTR

. b) Second Generation Computer
d) Fourth Generation

ERIITNE. YWTIRENBI)————~ 50@&30"6@ LIIBEONT.

¥) BRTO 2eVN0D (FOTRETT)
3) SNeTFeoD 2eerod (I0TRET?)

5. In the mouse scroll Button is used for

W) PTBIOD &eRROD (BopsT?)
®) m@ﬁeo:b 2o (ﬁoe\,;a TH)ahs

83 3YNT OINT TONFIR), AVFLID BPAF SIS 7@)@ mOBOIN mwo&@eﬁk‘gmgd?

a)Page UP  b) Page Down

6. Pick out the "wror.tg statement.

 a) Information Stored in RAM can be changed by over writing it.
b) Information stored in ROM cannot be changed by overwriting.
¢) Information can be stored in any location of RAM

d) Computer main memory can be accessed only sequentially

= ésiﬁﬁ@ﬁ@ow BTW BELFODY, oI 3r}oWD.

) Botha&b d) Neitheranor b

&) TRIFRY BeDORYL BRBIRIR, ST DOF  HeOIET FRE  LFERVETNG.
2) ROM 3 oinRe F96 Sntdcks, SO0 Hd BeIORRTEIINT. :

%) RAM S odgde ,u@ciej maaoaosm Be DORWBITONG.
B) O _;.bsééoﬁo aiwwﬁ mwe aoegaésbd aiad.faebod)& SBORWTBTNG.
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W7 Cﬁrrently used new version monitor is called
TR NWTOIRENIOWT BT LEPROD TBODR), — 0T FBO30TT.

a)GRT " . b) Black and white color
c) TFT ' d) None of these
-8.  One Terabyte is equivalent to.... : i
a) 1024 Mega bytes - b) 1060 Mega bytes
b) 1024 Kilobytes - . ' d) 1024 Giga bytes
2,00 BT~ ———1 RSOZWNT.
©) 1024 fn_emzidw: , , ) 1060 aﬁ)meséwfd .
3) 1024 S0 @) 1024 nerordEs

9. CADstandsfor__ .
A.D.B— }WO ARV  TRH

a) Computer Aided Design : b) Calculator and Desginer
c) Computer Automated Design ' . d) Compulsory Aided Design
10. Super computer Param 10000 is an example for » o
a) Second generation Computer b) Third generation Computer
c) Fourth generation- Computer ' d) Fifth generation Computer
ToXF 10000 |/TH BSR[POT FOBRWO R YVTOBTECIIDNG.
) ATVBEID SS[DOI : W) BDRTI0D B3[P0
%) DOYI0D IS0 L B) 630D 38T00R
11.  Which memory is volatile? Sens :
a) ROM _ b) EPROM - i ) ¢) RAM d) PROM
03303 FRWPEDOIN BoBS / POTIT (FpOES) SNS ? '
&) ROM %) EPROM ' 8) RAM . @) PROM

12. LPM Stands for
R .D.Q0 B VAT BRT——————=——

a) Lines Per Minute ~ b) Load Per Minute c) Links Per Minute ~ d) Loss per Minute
13. The Integrated Circuit is placed in..... : : : =
a) Motherboard ' ~b)card 0) Networking Interface card  d) None of these
_ BoEReEE IRNFE O ———————- AY }WRLNIT. :
®) G Beewe ) R 3) SL'JIFONT JOWT PR E'E @) SRPTR ©Y

is an éx'ample for Hardware L
QD CPOTOTF,  NWBTH SN :
a) Key Board : b) Microprocessor ¢) RAM Chip  d) All of these

14.

[P.T.O.



15.

16.

18.

19.

20.

Start button is present on

a) task Bar

AR THOR JBOTTH-

) xéan:azss TEGOD Woed
%) O}, Jegod e

b) Title Bar

It is not a default icon on the desktop..

¢) RunTime Operating System

6159 — IVS (DM) — CA— MAY - !

c) Menu Bar  d) Status Bar

W) SSWoT JeoD e
@) TOODFTEIOD 20e3

*d) None of these

a) My Computer - b) Recycle bin c) MS Word
83 %Y TVPITON BRI ¢S FIOY. ' ;
©) 3 BOTRET 2) 0AB DD B) A, I, IBF  B) BRPD ©Y
: Icon ismamed as
s gasbonm, et SH0mET
a) Turn off b) Log off = c) Restart d) Stand by
RTOS stands for
'RTOS |9%3 cD?o_"@S TR )
‘a) Real Time Operating System b) Real Time Operation System

d) Rum Time Operation System

The Menu bar in Notepad contains the following option.....
a) File->Edit->Search->Help ~ b) File->Edit->View->Insert

¢) File->Edit->Format->View->Help d) None of these

Joee *acs‘de‘)das DD @0° B ILNI eoﬂane}a&) &ao&d

€) e,:escf -> BT —> ITFE —> é@‘
) e,;def -> QR >, > @a’,oc;

3) F > BT —> POTIRE —> T, —> I,

- B) DI m@m O,

GUI Stands for.....

a) General Used Interface
c) BothAandB .

GUI 2ws &)73’@ 3 CRT

©) MRRT ORI, ROWT FHex®
3) © DR W VAR B

- b) Graphical User Interface

d) None of the above

W) RIS O0NRIT® QLT HER®
B) SSRITR Q.



21.

22,

23.

24,

25.

26.

27.
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X,

)
“~~ZIcon is named as .
a) My Network place - b) My Computer  c) Recycle bin -d) My Document
BRI au, bt SR0REs | :
ea) 3 23&3569' Bex W) By ToTWRET® 3) ORI’ O @) By TOBRIV0L
The Sound recorder is used for....... ' . e
a) Playing sound file . b) Recording sound file
- ¢) Editing sound file . g d) All of these
AP0 OBWETD), — . TN S0T03ReNRITT. »
©) PO PO, Fe BN L W) OB PO, 0TGF SRBEW
) TPOT PO, BEF SRBE B) S TePT YW/, WIBE
RTE Stands for......

a) Rich Text Format b) Real Time Fonts c) Real Time Files d) Rich Text Fonts
RTES c‘l)?_o;) 8 SR «

©) 0 B, RUBR’ (29) DeoDHer HHF PO,

%) Oeode® & B ~ (B) Deoder 85 | o,

Date and Time is present in.....

a) MS-Office - " b) My Document c) Control Panel  d) None of the above
83 INTHNSY __ Ber (Dz003) DP, B (SeP) I,

@) RO.DX’. BQCE w) &y csa?bdaoés‘ 3) 60&3@60‘ "?60‘("3) oSaa@cb ®Q.

In Calculator windows following menu exists ..
a) File->Edit->View->Help  b) F]le->Ed1t->Insert->Help

c) Edit->View->Help d) None of these

RORNIWT D0BRETTIY SRR FSS. |
) e,.gef >R > Fp, —> é@i , ) %@J‘ -> BT > ‘36‘70"?;3’? - B
3) IBE —> Jp, > BT : B) 3003 BRYTR Q.

Paintbrush File name extension is... :

a) ppt , : b) pbx ' c) bmp d) pex
BEOEFWT® a:’ep‘ aﬂéa@a‘ﬁ BRI &N, :

(®) ppt ) pbx © %) bmp @) pex

f@ This icon is named as : ;
a) Pick color b) Fill with color  ¢) Brush d) Air Brush

(@ 8 TSP, ——— Q0T 38030=e0 , :
¥) Wy ok 4 23) 289 i:aeab 5) 33 B) 07 FI°

2016

O
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28. Features of word processor are

a) To create documents, letters, banners, lables,
b) To Edit, format and save documents
) To Insert page number, symbols, objects.

| d) All of the above

29.

30.

31.

wdxomﬁdﬁd PN &3NS,

¥) TRREIMED, TINW, S, RITNI, FAWIHT
2))TBORTE, VTR W) TAVICLINTRY, YOPRT.

3) [RNLD, WINRD, 28 Jﬁ@éo a:b& iraee%ﬁﬁ@e& NGO,'JDQ)c:b

@) d:ecf)a @@aé;a

In MS-Word every command is available in..........

a) print -b) Icons ) Letter d) Digit

R0.0F.BEEIY BSKLOW SERWD Bz FINIYNI, VLA

©) QO / ORR ) DB / BEXD 8) SWo° 3) QW -

To CUT a text, PIess..:...... : : :
(@) CtrI+C Key : b) Ctrl+X Key c) Ctrl+A Key - d) Cul+V Key
TBFS), FTSOA CINPTR), VWBeTHSH? ] ’

) CTR_L+C Key 2)) CTRL+ XKey. B)CIRL+AKey = ®) CTRI+AV Key
“In MS-Word Pictures can be inserted by using.........

a) Insert-—> File 'b) Insert-—> Picture

¢) Insert-—> Symbol d) None of the above

D0.DF° wwrw 83 FENIPYNII), GVTOIRENA TBASRII), AORIBR.

©) JeORIIES ; ) Nebﬁo—zsg 6) ReOR IR0 BB, B) CIPPYTR VY

32. In MS-Word, we can convert the text into .....

33.

.a) Table b) Graph' c) Both (a) and (b) » -d) None of the above
RO, JIFFIY TJoP) TYIJW, 88 IINTOZ TRTLOBOZW TR - :

©) e’ / Ty W) T /I B) O DD 2 0D B) CSRDD OY
Pick the odd one out.. . :

‘a) Font ’ ‘b) Paragraph ¢) Mail Merge .d) Change case
FRNEY I mﬂd&@dﬁb &0 BRTSHOND.. : :

). ©38 ) TONMOFT 3) NS eE @) 23023 A

Which of the following shortcut key is used to check spelling and Grammar?

a) F1 b)F2 ) F7 d) F9
FINIJYNYY o3RI Totsr3e $eDON, foeDone/&msés TOLFRELD YV TodeeN=Zead?
) F1 W) F2 L ‘ - ®) F9 .



35.

36.

S

38.

39

40.

41.

42.
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PAGE NUMBER option is in __ memu.

a) Format ; b) Insert  c) View . d) None of the above
T8 o, soom 8 DAIVYW - -

©) TRODRES W) AREE 3) X, - B) yBe v
In MS-Word, the CHANGE CASE command has ..... .. option.. : ,
a) Sentence case b) Title case c) Upper case  d) All of the above
Q0. OF. IEFIY Weor® Fex* RAEWII 85 FINT - oHod), BeodT

¥) OV Fex° 2 W) BRe* 3ex7  3) oT0? 3T B) eI QTP

In NH, the characters “3" has to be below. Which effects has been applied?

a) Super Script ~ b) Lowered c) SubScript  d) Laid down
NH @09 3 20w 930 $9N08m) ammN oSRa I, B, WBIRNZSRNS

" ®) BRE0 AT, L W) SeeRoy 3) X’ A @) S @

In MS-Word to-go to the next line we have to pfess_ key from the keyboard.

a) Down Cursor key b) Enter key c) Shift+ Enter d) Control + Enter
R0. OF. BEFFIQY F0ITT IR Beened 3eBRBFAOT . — 3D, 2.3We.

®) @ FIFTT 3¢ ) Q0T ¢ 3) 37, + DouT* B) B083RCS’ + DOLT®

. In MS-Word, "COLLEGE" is an example for case

- a) Sentence _ b) Upper c) Lower d) Toggle
@0.0%. Swrsg "COLLEGE" am 3TN SUTRBTFRCIIAG: ‘
) Fosss W) oFT 3) deestt  ®) ne”
MS-Excel stands for..... .‘ S | '

a) Microsoft Excel  b) Excel Microsoft  ¢) Microsoft Excess d) None of the above
R0.DF° BT VBT BT ©NB. - : :

@)_ﬁada@,emap; DB W) 2B daéi{a)emaf_,' B) B BeRT, aﬁnf 3) SRPTR ©Q

a) Financial Calculation b) Business calculation
¢) General Calculation d) All of these

TORT Toend eeS: O3RFYTE, FHOOD FRRIH?

) SRR grasleadd ») ST ST
3) mma‘%-@%@ﬁ&-’ﬁ% @) [N QO

In MS-Excel the ROWS are specified by , :
a)A,B,C,D b)1,2,3, 4 9LILILIV dW,XY,Z

T, OF, 2FRY OFTNT), 88 0edo3wN BRORTT.

a)A,B,C,D b)1,2,34 o LILIIL IV d)W, XY, Z

[P.T.O.
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43. In MS-Excel, the function of () symbol is to perfornr_i ......

a) Addition ; b) Multiplication
c) Division® d) Subtraction
RO.DF.DFEIY () VRO FTF)——————- BB TN
&) BRI ) BRI
F) PONRJYT ' @) IOV
44. By default, how many sheets are opened in MS-Excel?.
a1 b2 03 . d) 4 .
PP DA".DFOTR), BTN, TOIE . ToWON—————— 5etr (D) STWIRNI.
)1 ’ : D)2 3) 3 ®) 4

45. The last column heading of a spreadsheet is !
TORE BIFODY FRF0D OO, BAH_- SN

. a)AZ : b) CZ
oIV - d) FX .
46. In MS—ExceI using key bbard to select the entire column by using keyboard.......
a) Ctrl + Spacebar b) Shift + Spacebar
c) Ctrl+End ~+ d) None of the above
DT DT . RESTY 3CBRTE QTOIRENIZLOTE. YR OO TWOD, S0, BRBO————— 2,336
¥) Cul +3ex" 207 W) 337, + R 20" %) Ctrl+End = @) ooR)T0
47. There are ___rows in.one excel worksheet. : . : :
~a)65536 . b) 9999 A c) 256 d) 999
3O3PTE DY ——————— TN QTI. - ] T
©) 65536 W) 9999 3) 256 &) 999
48. PMT function is an example for....... :
a) Logical function b) Statistical function
¢) Mathematical Function d) Financial function
PMT function / $OF————————— '&Cﬁ% YOOI,
) IVEFT JOJ = 23) xomémiepsa

3) méa?@:es IOI @) TRTAT POT.
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49. Icon is used to.....
a) Merge the cells into a single cell
b) Merge the cells into a single cell and align the contents at center
¢) Merge the cells into a single cell and align the contents at left
d) Merge the cells into a single cell and align the contents at right

'.és 28 0D =— e i WTOSRENTTT.

©) BREBNYRY, 8omd i@eswmhw@dé

) &raeemeém 20T a@eswm ﬁnnaé)dé B daaoemeéab mzsdeﬁ 363@:36

7) ©Jes &rae:meﬁab 20T &meswm‘iﬁ% a’oa’o @@m*ab acﬁmﬁ% DTG,

B) ©Je3 arawm;m 2OTH ZREJTID ﬁm@d% mcfo daaoeimﬂab womﬂé 36055)(53
50. In MS Excel, tabs present in page setup box are

a) Margins b) Page -~ c) Header and Footer d) All of these
RO.DT. DO T AFOT 2ITITT SO :
_ ©) BPVEI® W) T3 © B) VRO DB FRLT” B) eI QTP
51. In MS-Power point, forniétting toolbar is not available in....... :
 a) Slide view b) Outline view  ¢) Slide sorter view ~d) Notes view

AR, TS TR DR T, 30 O FBLRRY.

©) & & Seedd W) Teavonds Buwedd  7) B 438 O BET Swedd @) 83,6 Suoetd :
52. To print the power point presentation, press...... .

a) CIRLEFL : b) CT RL+E c) CTRL +S d) None of the above

TRT® moo &5 gdafs'swab dwd”co S TEOT 6@?«?53& %8 wleso.

" @) CTRL+L 2) CTRL+E %) CTRL+S @) BoedT SR 9,

53. We also give j in power point presentation :

a) Sound effects . - : b) Special effects

¢) Normal effects . ' : d) None of the above

T3 To0EF BRI wowy ), FRBRT.

DNT O w0meR : ) Db, momesd
T) Fopestd &omosd @) e sy w3,

54. The maximum zoom percentage in Microsoft Power pomt 18 _

a) 100% 'b) 200% c) 400% d) 500%

:Sodﬁra ezo®s, TONTT W &5T, ﬂb% Sof B3 a’ea’mm& BTy .

©) 100% : 2)200% ¥)400% @) 500% .

[P.T.O.



55.

56.

57

58.

59.

60.
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Which key on the keyboard can be used to view slide show?

&, 4B° B DITE), Seeden $ed Bow HOE 3ee) Dy, v JeenTeleTd?
Y e O b)F2. . OF5 d) F10
The extension of MS Powerpoint file is : s R
a) .mpeg : b) .doc . ©).ppt . d) .mp3
TR, TOWO® TWONO0EF a:.)’def a,gd?soi: SR : 5
©) .mpeg : 2) .doc ‘ %) .ppt @) .mpS :
Business graphics can be classified into........ . ‘
a) Presentation graphics b) Analytical graphics
c) Design graphics d) All of the above
BBTIOT 10 HFOD), B 868 WNCTORWIOWD.
) afsvm r%é’o#fo - ') DT eqr0ss ng&ﬁﬁ,
v) DR, t0 76, L B) BoedS DO
We can make slides in
a) MSPower point b)MS-Access -
c) MSExcel d) None of the above
T, ,BOTD, Y, CBIVIOW. ¥
) DR -DT® BTN &F - 20) DEF-DTE T T°
T) DBF-F° T 6 @) BeOT SPFYTR @),
In MS Power point, the shortcut key to Save the fileis_ -
a) CTREAS, - b) CTRL+V
O CIRL+C .~ d)CIRL+A
DBF-0FF TRO® T LIS, T8 Vead B 1 Ao
©) CTRL+S - . @) CTRL+V 2l e
%) CTRL+C T @) CTRL+A o
The view buttons are found__ ) of the presentation windows.....
‘a) At theright corner - b) At the upper left corner -
~ ¢) At the lower right corner  d) At the lower left corner
Qraé (Sweetl) ™ B0 a;:’) BIES & BREA S (a1S} FOBOWTOS &3,
©)OnE BRS DO, ©) SO 0B SR D&

T)WONB TE BRS DO . B) BCA T S 38,



T 62,
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61 Microsoft Access is an........... S :
a) DBMS ' b) DTP Software
c) Spread sheet d) None of the above
Sy TR eI T DT F © =3 :
Speaasie () ; =
©) BRIRT VR W) B3
%) & 430 Debs . @) BT 0T B
The Extension of MS-Access file is Gl - x
a)mdb | b) .bmd ¢) .dbm d) .mbd
DBE.OFF DY FOIS DZTEB Cloi- B & T
) .mdb %) .bmd- .- %) .dbm (x8) .mbd
63. The objects that are not present in MS-Access.... : :
~ a) Reports 'b) Modules c) Status d) Macros
DBF.DTF DT TR &350 PRI, BRODTLHAL.
) 5358 : 2) SRBEE, )BT (@) Sogwee
64. Number of queries available in MS-Access are ‘ Rt
a2 ~ b) 3 o b d) 7
DVFDTE DTFRQ o dNVSTINT B o
eYdal o 2)8 - 75 (@7
65. The following Data type is available in MS-Access ......... ,
a) Text b) Date & Time ¢) Numbe d) All of the above
OVFOFF DT TY,_ B3903 TS o3 I, - :
) =3, (texts) b) BTe I H F) S WG (B) eI DOTp
. 66. MS-Access deals with __ . £ o o :
a) Queries .b) Forms ~¢) Reports d) All of these
RVF. TP, DFT® S FYNT Iewd FeBTH, B BB.
®) BB8d (F Dde®) ‘ 20) Tmngh (esdferidd)
%) WO /Odbsoeceried L B) 86T QORI

FRTO.
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67. Different methods of creating tables in MS Access are.......

68..

69.

10!

74k

a) Create table in design view

~b) Create table by using wizard

c) Create table by entering data
d) All of these ;

DEF.. T, DT, BReFBMFAD,; I odedTeN JTI AFE____
®) VoGV AUeLLITe BroeRsar), B 030D

2)) DeREte T, VB SReNGBR B Beegsaad, TS,

%) B0 0Briga, BeDBRTS dpes BreRzR), TBRPE.

@) e P

_is a systematic way of representing information
a) Pages ~ b) Summary . ¢) Reports d) Note
BLSONI), TBEFALD WIRH B

 ©) Thurd ) B003 ) TPOSRY @) Reee
The following Data type is NOT is available in MS-Access... :
a) Text o b) Data ¢) Number - d) All the abc
B3 TEHT BIYOZ TFUR) HBFOFF &F, 5O ADHDY
©) B3, (text) 7 %) wokwo F)FoWT @) B0edT DO Tp
In MS-Access you find the following relationships. _
a) One to One b) One to Many c¢) Many to Many d) All of these
D0.DF. DI IY B3 FINT FOWOFNTR, VT TLITI =
&) a3 @ as : 23). 23 80 D . B) HD & D B) 0T Y
Internet is : : = :
a) A powerful Inter communication System b) A powerful Inter connecting Syste
c) Bothaand b ' d) None of the above
©03WHF O D03 - ' SN3.
©)33T0d ©OIT°* FOTBS Q@S% )BT ©OBT* BOTIE 555;33

- B) © B 2 A0BR ' - B) AWNIY P |Y
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72. To connect Internet you have to
- a) Type users name and press enter key
b) Type your password and press enter key
c) Type your email address and press enter key
d) Type your username, password and préss enter key

- ©TWrOF; F0TTE ST, Be0Ten desy)

S,

©) I, DT Fek B0 Sosy, HOLE 368 OBy 280,
) V33, BOTeSoF Brw, &;00 [T, DOKF e oD, 2.89.

%) Ay B-seer Dvormsy H)dh s, SO 6 oy W80,

B) IRy, IOTTTERF, TRFSTE By, DOHF 368 Oh, 8.0,

73. Yahooisa on Internet

a) Search engine “b) Help engine
~ b) Kernel d) None of the above

POZWFOTY XRBR ____ 033,

®) Zeers oo : W) FTORT 020

3) JoFS* 'd)daeés O3RT &
74. WWW stands for ,

a) World Wide Web b) World Wide Wonder

¢) Bothaand b | . d) None of the above

WWW - 338 QB ToRH__

© ©) DS E 3,06 Fud 2)sef B, S B
@) BoedS SEYTBR B,

%) © &30, 2 BFSER

75. VSNL is the service p‘rovidef 17

a) India
VSNL & =200z

©)23903

76 ‘BCC stands for
a) Blind Carbon Copy

b) America 5t Q) Russia d) China
Bewo HITT e2AT. :
2)) ©9a30e0%D %) B0 @) 23¢9

b) Black Carbon Copy  c¢) Blank Carbon Copy  d) All of these

BCC 9wt 50,1)3 BRT  SAT

) B W TP

zb) W TWES TP 3) POT TWEFS TP cg)méaf TOWEFDS T

77. The following domain is Geographic domain...... -
83 FPNT SN LPRREYT SoLNTINS.

a) .com

b) .net c) .edu d) .au .
PO
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78. To check your e-mail

a) Sign in-> Login->Inbox . ‘ b) Signup->Login->Inbox

c) Inbox->Login->Login | “neel) Logfn—>Sign in->Inbox

B-3e® FOTEBIRY, "B, B IINT LWFFLBIODY DesY FT BPELE

®) FD° A° -> AT -> YIUWRT, 2) B AW -> PRY’ -> QIRT,
3) }IWIT -> CONT'. -> RN BEF B) SR’ ->AF A -> AT,

79. Following activities can be performed if one has access to Internet
a) You can have electronic copy of journals and magazines from the Internet
b) You can refer to the picture of an art gallery :
¢) You can send mail across the boundaries in time

~ d) All of the above .
©OBWFO FOTFF BROOTY 8 FINIYNYY ol s RY,
©) S0FFOT RRVT AWM FOWING Tone BIFONY TSCLTY) BROTWIW.
) EHFF TRE0CDY RTIF BIRFR, TOAESF SRENBWD. :
3) AcDPSeIToN B IAXD IDOPTY FoWEBNIR, IRLRWTOW.  B) WIT ARRNTIR

80. Khoj is an search engine. '
a) American " b)Russian  ¢) Indian d) Chinese
BreE* 20D By 0D0ZHON3. ' -
®) 90T : ) S0 3) QoROI* B) BRex°
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FOURTH SEMESTER B.A. DEGREE EXAMINATION, MAY 2016

POLITICAL SCIENCE ,
COMPARATIVE GOVERNMENT AND POLITICS

-Time : 3 Hours] _ [Maximum Mazles=-8
: : Q&s
3 : /\ RSP
Answer any five questions. )
Question No. 8 is compulsory. :

All questions carry equal marks.

1. Discuss the meaning, nature and scope of Comparative Government and Politics. .;Q_“ff
2. Explain the salient features of England Constitution. :
3. Discuss the powers and functions of Prime Minister of England.
4. Examine the composition, powers and functions of House of Representatives of Amefica.
5. Discuss fche Judicial System of England.
6. Describe the composition, powers and functions of Supreme Court of America.
7. Ekplain the Political Party System in America.
8. Write short notes on any two:
a) Position of King/Queen in England.
b) Vice President of America.
cr) Speaker of the House of Commons.

d) House of Lords.

[P.T.O.
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5T 2TE L3S WOeWD :

a) BOTOT Tt [TEI03d WTRRS.
b) &g VTG,

¢) R, Ao P8,

d) X ST oBF,




